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CUSTOMER RESOURCE OPTIONS 

Supporting users throughout their entire journey of learning MBSE is central to Vitech’s mission. For users 
looking for additional resources outside of this document, please refer to the links below. Alternatively, all 
links may be found at www.vitechcorp.com/resources. 

 

Webinars 

Webinar archive with over 40 
hours of premium industry and 
tool-specific content. 

 

 

Screencasts 

Short videos to guide users 
through installation and usage of 

Vitech software.  

 

A Primer for Model-Based 
Systems Engineering 

Our free eBook and our most 
popular resource for new and 
experienced practitioners alike. 

 

Help Files 

Searchable online access to 
Vitech software help files. 

 

Technical Papers  

Library of technical and white 
papers for download, authored 
by Vitech systems engineers. 

 

MySupport 

Knowledge Base, Exclusive 
Webinars and Screencasts, Chat 
Support, Documents, Download 
Archive, etc.  

 

Our team has also created resources libraries customized for your experience level: 

All Resources  Advanced 
   

Beginner  IT / Sys Admin 
   

Intermediate  Student 

http://www.vitechcorp.com/resources/video_archive.php
http://www.vitechcorp.com/resources/screencasts.php
http://www.vitechcorp.com/resources/mbse.shtml
http://www.vitechcorp.com/resources/mbse.shtml
http://www.vitechcorp.com/resources/core/onlinehelp/desktop/Welcome.htm
http://www.vitechcorp.com/resources/technical_papers.php
http://www.vitechcorp.com/MySupport/support/Login.aspx?ReturnUrl=%2fMySupport%2fsupport%2fdefault.aspx
http://www.vitechcorp.com/resources/index.shtml
http://www.vitechcorp.com/resources/advanced.shtml
http://www.vitechcorp.com/resources/beginner.shtml
http://www.vitechcorp.com/resources/it_sysadmin.shtml
http://www.vitechcorp.com/resources/intermediate.shtml
http://www.vitechcorp.com/resources/student.shtml
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INTRODUCTION 

Welcome to the CORE® 9 University Edition Installation Guide. This guide is intended to assist you with the 
steps required for getting started using the most robust systems engineering software tool available today. 
This guide will take you through: 

1. Installing the software.  

2. Obtaining an activation key.  

3. Starting CORE.  

4. Accessing additional guidance and resources available to help you use CORE. 

If you have any problems or questions regarding installation of CORE 9 University Edition, contact us: 

 

University Program Manager 
+1 540.951.3322 x106 

universityprogram@vitechcorp.com 

 

For information on systems engineering and CORE training 
Visit our website at www.vitechcorp.com 

+1 540.951.3322 
info@vitechcorp.com  

WHY USE CORE? 

Developing complex systems requires more than today’s office software and requirements tools can deliver. 
Product engineering and architecting demand a powerful support environment for life-cycle design. 
Whether designing a commercial product, an IT service, or a military system, satisfying diverse customers 
under schedule and budget constraints requires an integrated solution—a solution to synchronize 
requirements, analysis, and architecture; a solution to guarantee consistency and reduce risk; a solution to 
deliver technical and management insight into complex issues. That solution is CORE. 

CORE is a fully integrated, flexible approach to collaborative product design specifically developed by 
systems engineers for systems engineers. In fact, 9 out of the 10 top U.S. defense contractors are Vitech 
customers, along with many of the Fortune 500 companies. Supported by an experienced staff of 
engineering professionals with real-world knowledge of the latest approaches and proven project 
experience, CORE puts project success first. 

Moving beyond the document-centric or view-centric packages of the past, CORE delivers a truly 
collaborative design-centric approach to product development. CORE provides comprehensive traceability 
from need definition through requirements and analysis to architecture and test. Built upon a proven 
approach and a central integrated design repository, CORE includes extensive function and behavior 
modeling notations to better understand the dynamics of your design, integrated product simulation derived 
directly from your models, and on-demand automatic document and view generation. With numerous views 
tailored to the multitude of engineering and management tasks, CORE enables your team to focus on 
engineering and architecting your system.  

Whether your project requires formal design specifications or informal web-based documentation, strict 
processes or agile design explorations, top-down approaches to a new system or middle-out/bottom-up 
reengineering of existing systems, CORE supports your needs. 

  

mailto:universityprogram@vitechcorp.com
http://www.vitechcorp.com/
mailto:info@vitechcorp.com
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CORE in the Classroom 

Vitech products are used each year by Each year, thousands of students are able to use the CORE 
University Edition at no cost in their classrooms. Vitech offers this option because we truly believe that 
investing in education is the best way to accomplish our global mission of changing the systems engineering 
world. At Vitech, we believe system thinking and our solutions can help address many of the challenges 
facing society. We understand that we are opposed by strong “forces of nature” such as apathy, 
complacency, ignorance, expediency, and preconceived notions of systems disciplines, but students who 
are ready to learn are partners in resisting those forces.  

By using CORE in your learning environment, you are taking part in the greater mission to change how we 
all operate for the better. CORE is more than a software tool – it is a partner in your endeavors to take full 
advantage of a different way of thinking – model-based systems engineering (MBSE).  

For those students who are not familiar with the concepts behind MBSE, or who would like to know more 
about it, we invite you to download the free PDF copy of “A Primer for Model-Based Systems Engineering” 
by David Long and Zane Scott at the following link: 

http://www.vitechcorp.com/resources/mbse.shtml 

Or purchasing a bound copy from Amazon.com. 

Learning CORE 

As a software product that is powerful enough to handle the most complex of design, simulation, modeling, 
and documentation needs, getting the most out of the product requires some training. In particular, Vitech 
advices students new to CORE to use the various resources listed under CORE Help and Documentation 
in this document. In addition, students have access to the following areas: 

http://www.vitechcorp.com/resources/index.shtml - includes screencasts, webinar recordings, white 
papers, technical studies, and case studies regarding CORE and general systems engineering 

http://community.vitechcorp.com/forum/ - this page is full of great tips, tricks, and discussions revolving 
around CORE and MBSE.  

In addition, support is available every weekday at the contact info listed on page 1.  

Want to see CORE where you work? 

Many of our University Program participants are continuing their education while they work in a variety of 
industries, ranging from defense to energy and software development to healthcare. For the students who 
aren’t already working, they often find themselves employed post-graduation in these same industries. After 
getting a taste of what CORE can do in class projects, our students quickly realize the possibilities of what 
it could mean for complexity management at their workplaces.  

If you’d like to bring Vitech to your office in the form of CORE software, training, or professional services, 
Vitech will work with you to provide demonstrations, evaluation copies of the software, and other information 
on designing a custom MBSE solution for you. Just send an email to universityprogram@vitechcorp.com 
to get started!  

 

  

http://www.vitechcorp.com/resources/mbse.shtml
http://www.amazon.com/Primer-For-Model-Based-Systems-Engineering/dp/1105588106/ref=sr_1_1?ie=UTF8&qid=1374167055&sr=8-1&keywords=primer+for+model-based+systems+engineering
http://www.vitechcorp.com/resources/index.shtml
http://community.vitechcorp.com/forum/
mailto:universityprogram@vitechcorp.com
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What’s included - CORE University Edition 

This University Edition of CORE is provided under special agreement for academic use only. For a more 
detailed description of the CORE product line, see the Overview of the CORE Product Family.  

The University Edition of CORE is identical to the commercial version of CORE Spectrum with the following 
exceptions: 

 The license will expire in alignment with the instructor’s class schedule.  

 The capability to save an image file, which stores the data in a fast binary format in order to 
eliminate the import/export cycle, has been disabled. 

 The University Edition will import/export CORE database files in binary format instead of XML 
format.  

 The capability to maintain a recovery log has been disabled. 

 Only the following subset of reports from the full version of CORE 9 are available (see the website 
for additional information): 

- Queries and Consistency Checks 

 Item Consistency 

 Keyword Search 

 No Descriptions Query 

 Open Issues Query 

 Recursion Query 

 Unallocated Leaf-Level Function Query 

 Unallocated Leaf-Level Requirements Query 

 Unverified Leaf-Level Requirements Query 
- Systems Engineering 

 Generic Table Output 

 HTML Report 

 IDEF0 Node Index 

 System Description Document (SDD) 

- Other 

 Database Statistics Report 

 Schema Definition Report 

- DoDAF 

 For those courses where instructors have requested it, the University Edition also 
includes DoDAF reports and the supporting schema. 

 The Administrative Tools, which allows multiple users and groups to be created and provides other 
administrative functions within the CORE environment, has been disabled. 

 Users are limited to a single project. 

 Each class is limited to 200 elements. 

 CSV export capability has been disabled. 

 The DOORS Connector has been disabled. 
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Functional Capabilities University License 
Commercial License 

(Essentials and Spectrum) 

Multi-user access controls  X 

Data exchange with other tools  X 

Consistency checks X X 

Completeness checks X X 

Customized tabular output X X 

IDEF0 node index X X 

System description document X X 

Database statistics report X X 

Web page output X X 

Database size 200 objects for each data class Unlimited 

Custom reports X X 

Simultaneous projects  X 

Schema changes Unlimited Unlimited 

Architecture frameworks (DoDAF) 
Optional 

 (if requested by instructor) 
X 

Government specifications  X 

Model-based systems engineering X X 

Business process modeling X X 

Comprehensive traceability X X 

Behavior modeling and analysis X X 

Behavior model simulation X X 

Embedded simulation operands  X 

Resource modeling X X 

Requirements management and analysis X X 

Risk management X X 

Program management X X 

Verification and validation X X 

Work breakdown structures X X 

Product/component structure X X 

Item and data flow X X 

Traditional (structured) and SysML representations X X 

Model integration X X 

Import and export of change files      X 

CSV export capabilities  X 

 

If you wish to use CORE for commercial or other purposes, please contact Vitech Corporation at 
+1.540.951.3322 or via e-mail at info@vitechcorp.com. Vitech has an official price list which provides for 
indefinite and evaluation licenses for CORE as well as system engineering training classes and purchased 
technical services. 

mailto:support@vitechcorp.com
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INSTALLING CORE 9 UNIVERSITY EDITION 

The following section provides step-by-step instructions for installing the University Edition of CORE 9. If 
you still require assistance after following the steps in this guide, please contact Vitech Customer Support 
at +1.540.951.3999 or via email at support@vitechcorp.com. 

1. You can download the CORE 9 University Edition installer from the Vitech website at 
http://www.vitechcorp.com/downloads/index.shtml.   

2. Click on the installer to activate the InstallShield Wizard. In the InstallShield Wizard window, click 
Next. 

 

3. Review the end-user license agreement which governs the use of CORE. If you accept the terms 
of the license agreement, click the radio button next to “I accept” and then click Next to proceed 
with the installation. If you do not accept the terms of the license agreement, click Cancel to end 
the installation. 

 

http://www.vitechcorp.com/support/downloads.html
http://www.vitechcorp.com/downloads/index.shtml
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4. Type your name in the User Name field. 

5. Type your organization’s name in the Organization field.  

6. If CORE should be accessible to any user who logs in to this machine, click the radio button 
“Anyone who uses this computer.” If CORE should only be accessible to this user account, click 
“Only for me.” Then click Next. 

 

7. The installation wizard prompts you for the location to install CORE. By default, Windows 
applications are installed to the program files directory. You can either: 

 Confirm the location and click Next. 

OR 

 Click Change to select a different installation location; then click Next after selecting the 
alternate location. 
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8. Select the setup type. A Complete installation (recommended) will install the CORE application 
and documentation files. A Custom installation will provide you the option to exclude the 
documentation. Once the setup type has been selected, click Next. 

 

9. CORE reports can be configured to use either US Letter or A4 paper. Select the appropriate paper 
size and click Next. 
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10. Click Install to begin the installation or click Back to change settings.  

 

11. After the installation routine completes, click Finish. 
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REGISTERING CORE 9 UNIVERSITY EDITION 

Before using CORE University Edition, you must first register and request an activation key. CORE walks 
you through the process below when you first launch the University Edition. The following section provides 
step-by-step instructions for completing the registration process. If you still require assistance after following 
the steps in this guide or if you encounter any problems, please contact Vitech Customer Support at 
+1.540.951.3999 or via email at support@vitechcorp.com. 

1. From the Windows Start menu, select All Programs > CORE 9 University > CORE 9 University.   

2. Select the Request Key button shown below.  This will open your web browser and take you directly 
to the CORE University Edition registration page on the Vitech website.  

 

  

mailto:support@vitechcorp.com
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3. You will be asked to provide your contact information including name, email address, university, 
instructor name, and the password provided by your professor. Select “Request Activation Key” 
and you will automatically receive an activation key via email after completing registration. 

 

4. Copy the activation key from the email into the activation key field shown Step 2.  Click OK. 
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GETTING STARTED 

1. When you first launch CORE University Edition, you will see a message similar to the one shown 
below indicating how many days remain before the CORE University Edition expires at the end of 
your course. You will periodically be reminded as the expiration date approaches. Click OK to get 
started. 

 

2.  The project explorer below is your starting place for learning to use CORE. The Icon Reference 

Guide available from Help > Docs is a useful desktop tool as you start using CORE. 
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3. The University Edition is restricted and only allows you to work in one project at a time. Therefore, 
the Open Project and New Project links shown above are disabled in the University Edition. When 
you open CORE 9 University Edition, you are already in a blank project and can start adding data 
to the engineering repository by double-clicking on one of the elements in the left-hand list shown 
in the screen above. When you're done for the session, you'll need to save your information by 
exporting the data to a file using File > Export. When you want to start the next time, you'll import 
the data using File > Import and import the file you’d saved previously. Try this by going to File > 
Import to import one of the Samples described in the next section. 

 

Sample Solutions 

The Samples directory within your CORE University Edition installation provides sample definitions of four 
sample projects. These files can be imported into CORE to view and manipulate. A requirements source 
document has been provided for some samples (i.e.,GeospatialLibrarySourceDocument.doc and 
FastFoodSourceDocument.doc). 

The sample directory does contain files for the elevator problem used in Dr. Dennis M. Buede's book, The 
Engineering Design of Systems: Models and Methods (Wiley Interscience, 2000,  
ISBN 0-471-28225-1). 

CORE Help and Documentation 

The CORE user reference guide is accessible as a reference available from within CORE University Edition. 
To access context sensitive help from a specific window, simply click in the window and press the F1 
function key. If you prefer to navigate by volume, flip through the index, or simply perform an electronic 
search, the help files will meet your needs. Also available from the CORE 9 University Edition program 
group entry on the Windows Start menu are shortcuts to documentation including: 

 What’s New 
 Guided Tour 
 CORE System Definition Guide 
 CORE Architecture Definition Guide 
 CORE Icon Reference Guide 
 COREsim User Guide 
 MBSE Primer 

 
Adobe's Acrobat Reader is needed to view this documentation. You can download the latest version of 
Adobe Acrobat Reader free of charge at http://www.adobe.com. 
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LEARNING MORE ABOUT CORE 

The section below describes some of the features of CORE that you may wish to explore. 

CORE Features to Evaluate 

Requirements Analysis and Management 

 Supports requirements elicitation 

 Captures requirements from multiple sources 

 Traces requirements to requirements and design elements 

 Identifies and manages issues and risks 

 Analyzes and decomposes requirements using both graphics and text 

 Maintains consistency with behavior, architecture, and V&V  

Behavior Analysis 

 Models system and process functionality 

 Decomposes behavior hierarchically for layered development and analysis 

 Provides integrated views including both functions and data to improve analysis 

 Allocates functionality to physical architecture 

 Provides multiple graphical representations [EFFBD, IDEF0, N2, …] of functional design 

 Ensures design integrity with a single underlying model  

 Executes models for dynamic verification  

 Maintains consistency with requirements, architecture, and V&V  

Architecture Analysis 

 Models the physical and logical architectures  

 Supports multiple graphical representations of architecture decomposition and interrelationships 

 Accommodates COTS systems and components 

 Identifies and manages internal and external interfaces 

 Characterizes the implementation of logical interfaces  

 Computes numerical roll-ups across hierarchical design 

 Develops alternative architectures for comparison 

 Maintains consistency with requirements, behavior, and V&V 

Verification and Validation 

 Develops verification requirements and plans  

 Verifies architectures through dynamic execution of behavior models 

 Validates requirements with behavior, physical, and verification models 

 Manages all aspects of V&V from planning through specific events and results 

 Maintains consistency with requirements, behavior, and architecture 

Document and Report Generation 

 Generates on-demand system specifications, reports, queries, and views 

 Supports standard text and graphic file formats [XML, HTML, DOC, RTF, CSV, ASCII, JPG, PNG, 
WMF, …] 

 Provides end-to-end traceability (forward and reverse) 

 Supports complete impact analysis (requirement, behavior, and architecture changes) 

 Captures programmatic data including schedules and WBS 

 Collaborates through stand-alone, enterprise, and web deployment 

 Delivers true design integrity through a design-centric repository with view and document 
generators  

 Supports via top-down, middle-out, and bottom-up analysis (forward and reverse engineering) 

 Integrates DoDAF with system design 

 Facilitates design and communication using a layered approach 
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 Incorporates a baseline schema based upon 30 years of research 

 Allows customization of language and reports  

 Reduces production of documentation and views to a byproduct of system design  

CORE Training 

Vitech offers ongoing training to help users learn more about using CORE in support of systems engineering 
and architecture frameworks including: 

 MBSE/CORE Basic Course – Provides the basic concepts of the MBSE Methodology and the 
skills for model building in CORE 

 Scripting in CORE – CORE can be tailored in a number of ways to suit the needs of the individual 
customer.  This course shows how to do that using CORE’s scripting capabilities. 

For more information on any of these courses, please visit our website or call Vitech at +1 540.951.3322. 

UNINSTALLING CORE 9 UNIVERSITY 

To remove CORE 9 University from your system, select Add/Remove Programs from the Windows control 
panel. Select CORE 9 University from the list of applications available to uninstall and click the Add/Remove 
button. Follow the instructions provided by the installer to remove the application. 
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OVERVIEW OF THE CORE PRODUCT FAMILY 

CORE is the premier tool supporting MBSE and product design including requirements analysis, behavioral 
analysis, architecture definition, verification, and design validation within an engineering or business 
process modeling project. 

CORE Essentials 

CORE Essentials provides individuals, small teams, and distributed users a complete MBSE development 
solution ready for immediate use against a locally installed and maintained repository – yet also adds the 
ability to connect to a collaborative design environment as required. Enjoy a robust product that includes a 
rich requirements management capability, multiple modeling notations, and integrated discrete-event 
simulation, comprehensive architecture analysis, verification and validation, and robust, on-demand 
documentation. 

CORE Spectrum 

Incorporating all of the features found in CORE Essentials, CORE Spectrum delivers comprehensive 
support for DoDAF 2.0 and SysML, providing a single vehicle that enables team-wide perspective and 
analysis and the industry-exclusive ability to deliver answers and insight in multiple formats, regardless of 
the input approach.   

Whether working independently or as part of the collaborative enterprise team, Spectrum provides the 
ultimate answer in capability and flexibility. 

CORE Server 

Part of a large, complex, or data-rich effort?  Add CORE Server as a remote repository and enable CORE 
Essentials and CORE Spectrum users the ability to operate offline and independently or as part of the 
collaborative engineering team operating together in one concurrent database. Easily maintained and time-
tested with over a decade in use, CORE Server provides a secure, convenient gateway for the team to 
operate in unison, taking advantage of the team-wide consolidation of information. 

As the engineering team centerpiece, CORE Server offers unparalleled ease of use, team-wide system-
level insight, live access to the latest system changes, comprehensive analysis, and instant, thorough 
documentation. 

CORE2net Web Server 

CORE2net extends your CORE Server environment to the web.  As a separately licensed component of 
the CORE Server, the CORE2net web server allows you to query the current information contained in the 
CORE systems definition repository, enabling design changes and real-time sharing of the current design 
state.  

CORE2net enables inter- and intra-team collaboration at the enterprise level with the ability to set up 
appropriate access permissions; authorized team members simply log into the project website using a web 
browser such as Microsoft Internet Explorer®.   Engineers no longer need to be co-located in order to 
participate in a design effort. Managers and other reviewers can access their data in familiar formats 
(tabular, graphical, and hyperlinked) from any location. 
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